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Vivien Release 1.2  
Release Notes

January 8, 2007 
These release notes provide the most up-to-date information about content and fixes 
made to the application. This document includes a list of the content made available in 
all post-release Updates, as well as the list of features and fixes posted in the original 
release notes. 

• Vivien 1.2.2 Update (January 2007) 
• Vivien 1.2.1 Update (April 2006) 
• Vivien 1.2 (March 2006) 

 
 

Vivien 1.2.2 Update (January 2007) 
 
Please be advised that Updates are provided with a minimal level of testing and should 
be installed only if you are experiencing any of the problems noted below. CAST 
Software provides no guarantee with respect to the stability of the fix. All fixes will be 
integrated into the next Release and will be thoroughly tested at that time.  
 

 
Fixes 
 
The Vivien 1.2.2 Update includes the following fixes: 
 

 
When you merge items from one Vivien file into another, the objects are now 
placed accurately in the new file 
 
When merging objects saved from one Vivien file into a new Vivien file, and choosing the 
Base Point with your mouse, the Merge function was placing objects at an incorrect 
location. This issue has now been fixed.  
 

 
Vivien no longer crashes when you open it and manipulate objects for the first 
time 
 
The first time you open Vivien, the program crashes when you add and manipulate 
objects on the Drawing Wireframe or Drawing Quad tabs, or when you click the Virtual 
View tab. This issue has now been fixed. 
 

 
Vivien no longer crashes when you click the Tools menu while on the Drawing 
Quad tab, in the Virtual View quadrant 
 
While on the Drawing Quad tab, if you highlight the Virtual View quadrant and then click 
the Tools menu, Vivien would crash. This issue no longer occurs. 
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Workarounds 
 
The Vivien 1.2.2 Update includes the following workaround for a known issue: 
 
Issue: You click the Layouts tab, create and attempt to save a new Layout and Vivien 
crashes. 
 
Workaround: This issue results from a conflict between the Layouts tab and the default 
printer configured on your computer. As a workaround, you have three options: 

• If you have an alternate printer that doesn't cause a crash, set it to be the default. 
• If you have Microsoft Office installed, you will have a virtual printer called 

Microsoft Office Document Imaging Writer. Set this printer to be the default. After 
doing so, you can print your spreadsheets/layouts/reports/etc. to this virtual 
printer, and then use the Microsoft Office Document Imaging program (Start-
>Programs->Microsoft Office->Microsoft Office Tools) to print the file to your real 
printer. 

• You can install and use an alternate virtual printer, such as Adobe Acrobat 
Distiller or PDFCreator.  

 
 

Installing the Update 
 
To install the Vivien 1.2.2 Update 
 

1. On the Vivien Web site (www.viviendesign.com), click the link for the Update file. 
2. At the prompt, click Save to save the file on your computer.  
3. Once the file has downloaded completely, double-click it to begin the installation. 
4. When the installation is complete, click Finish. The appropriate .exe file in your 

Vivien/Bin folder is updated. 
5. You can now start Vivien and work in it as you would normally. 

 
 

Vivien 1.2.1 Update (April 2006) 
 
Please be advised that Updates are provided with a minimal level of testing and should 
be installed only if you are experiencing any of the problems noted below. CAST 
Software provides no guarantee with respect to the stability of the fix. All fixes will be 
integrated into the next Release and will be thoroughly tested at that time.  
 

 
Fixes 
 
The Vivien 1.2.1 Update includes the following fixes: 

You can now open Vivien 1.0 and 1.1 files that contain walls 

Previously, when opening a file in Vivien 1.2 that contained a wall and was created and 
saved in a previous version of Vivien, an error message appeared, saying there had 
been an access violation, and Vivien would close. This issue no longer occurs. You can 
now open and work with these files in Vivien 1.2. 

 

http://www.viviendesign.com/
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Improved reliability on multi-CPU platforms (including dual processor, dual core 
and hyperthreading) 

Vivien has been upgraded to offer improved reliability when running on computers that 
have dual processors, dual core CPUs, or hyperthreading CPUs. 

 
Installing the Update 
 
To install the 1.2.1 Update 
 

1. On the Vivien Web site (www.viviendesign.com), click the link for the Update file. 
2. At the prompt, click Save to save the file on your computer.  
3. Once the file has downloaded completely, double-click it to begin the installation. 
4. When the installation is complete, click Finish. The appropriate .exe file in your 

Vivien/Bin folder is updated. 
5. You can now start Vivien and work in it as you would normally. 

 
 

Vivien 1.2 (March 2006) 
Thank you for installing Vivien Version 1.2. These release notes provide the most up-to-
date information about known issues and documentation. 

 
To Help You Get Started with Vivien 
To help you get started using Vivien, a number of sample files and various 
documentation sources are available for your use.  

 
Documentation sources 
Documentation sources are available in several locations for your convenience: 

! from the Vivien Install panel during installation 

! on the Vivien Version 1.2 CD (in the \Support Documentation folder) 

! from the Start>Programs>Vivien shortcut menu (once Vivien has been installed) 

! from the CAST Web site http://www.cast-soft.com/ 

Sources include: 
! User’s Guide 

! Getting Started Guide 

! Release Notes  

Sample files 
Sample Vivien files are provided with the installation for you to use as examples or 
references. These files can be found in the \Samples folder where you installed Vivien 
(for example, C:\Program Files\Vivien\Samples).  

 
 

http://www.viviendesign.com/
http://www.cast-soft.com/
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Vivien and WYSIWYG 
Vivien is fully compatible with CAST Software’s award-winning lighting design software 
suite, WYSIWYG. You can create your events in Vivien and then open the files in 
WYSIWYG if you want to add even more sophisticated lighting effects.  

 
New in Vivien 1.2 
Vivien version 1.2 contains the following new features: 

• Projection Wizard  You can use this new wizard to add screens and projectors 
to your drawings. It enables you to choose from a number of styles of screens 
and projectors, customize them to suit your event, and place an image on the 
screen (from a graphic file that is saved in one of six formats—.bmp, .jpg, .gif, 
.tiff, .png, or .tga). The wireframe view of your drawing accurately represents the 
dimensions and spacing of the projector and screen, showing you how to set 
them up in real-life for optimum viewing.  

• Import floorplans  You can now import into your Vivien drawings existing 
floorplans that you have saved in one of six graphic formats—.bmp, .jpg, .gif, .tiff, 
.png, or .tga. When importing the file, you specify the scale at which you want to 
import it. This enables you to accurately represent the venue for your event 
before you draw items or place objects from Vivien’s library in it.  

• Export plots  You can now export your plots to one of six graphic formats—
.bmp, .jpg, .gif, .tiff, .png, or .tga. This feature enables you to save a picture of the 
plot so you can distribute it more easily by e-mail or print it to the desired printer. 

 
In-Place Update 
The In-Place update available with Version 1.2 will update Version 1.1 of Vivien to the 
current release (version 1.2). This update is available on the Vivien CD and from the 
Cast Web site (http://www.cast-soft.com/cast/software/downloads.jsp). 

 
Library Additions 
 
The following additions were made to the library in this release: 

Additions to Library Items (Furniture) 
 
Item Comment 
3ft Round Folding Table  New Table (Folding legs) 
4ft Round Folding Table New Table (Folding legs) 
5ft Round Folding Table New Table (Folding legs) 
6ft Round Folding Table New Table (Folding legs) 
3ft Round Folding Table_4 chairs_no skirt New Folding Round Table 
3ft Round Folding Table_6 chairs_no skirt New Folding Round Table 
4ft Round Folding Table_4 chairs_no skirt New Folding Round Table 
4ft Round Folding Table_6 chairs_no skirt New Folding Round Table 
4ft Round Folding Table_8 chairs_no skirt New Folding Round Table 
5ft Round Folding Table_10 chairs_no skirt New Folding Round Table 

 

http://www.cast-soft.com/cast/software/downloads.jsp
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Item Comment 
5ft Round Folding Table_4 chairs_no skirt New Folding Round Table 
5ft Round Folding Table_6 chairs_no skirt New Folding Round Table 
5ft Round Folding Table_8 chairs_no skirt New Folding Round Table 
6ft Round Folding Table_10 chairs_no skirt New Folding Round Table 
6ft Round Folding Table_12 chairs_no skirt New Folding Round Table 
6ft Round Folding Table_8 chairs_no skirt New Folding Round Table 

Additions to Library Items (People) 

Person Position Type Position Name 
Business Man Standing Standing 1 
  Standing 2 
  Standing 3 
  Standing 4 
  Standing 5 
  Standing 6 
  Standing 7 
  Standing 8 
 Sitting Sitting 1 
  Sitting 2 
  Sitting 3 
  Sitting 4 
  Sitting 5 
 Reclining Reclining 1 
  Reclining 2 
  Reclining 3 
  Reclining 4 
  Reclining 5 
  Reclining 6 
 Walking Walking 1 
  Walking 2 
  Walking 3 
  Walking 4 
  Walking 5 
  Walking 6 
  Walking 7 
 Running Running 1 
  Running 2 
  Running 3 
  Running 4 
  Running 5 
  Running 6 
 Jumping Jumping 1 
  Jumping 2 
  Jumping 3 
 Sports Fencing 1 
  Baseball 1 
  Golfing 1 
 Creative Guitar 1 
Casual Man Standing Standing 1 
  Standing 2 
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Person Position Type Position Name 
Casual Man (cont’d)  Standing 3 
  Standing 4 
  Standing 5 
  Standing 6 
  Standing 7 
  Standing 8 
 Sitting Sitting 1 
  Sitting 2 
  Sitting 3 
  Sitting 4 
  Sitting 5 
 Reclining Reclining 1 
  Reclining 2 
  Reclining 3 
  Reclining 4 
  Reclining 5 
  Reclining 6 
 Walking Walking 1 
  Walking 2 
  Walking 3 
  Walking 4 
  Walking 5 
  Walking 6 
  Walking 7 
 Running Running 1 
  Running 2 
  Running 3 
  Running 4 
  Running 5 
  Running 6 
 Jumping Jumping 1 
  Jumping 2 
  Jumping 3 
 Sports Fencing 1 
  Baseball 1 
  Golfing 1 
 Creative Guitar 1 
Business Woman Standing Standing 1 
  Standing 2 
  Standing 3 
  Standing 4 
  Standing 5 
  Standing 6 
  Standing 7 
  Standing 8 
 Sitting Sitting 1 
  Sitting 2 
  Sitting 3 
  Sitting 4 
  Sitting 5 
 Reclining Reclining 1 
  Reclining 2 
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Person Position Type Position Name 
Business Woman (cont’d)  Reclining 3 
  Reclining 4 
  Reclining 5 
  Reclining 6 
 Walking Walking 1 
  Walking 2 
  Walking 3 
  Walking 4 
  Walking 5 
  Walking 6 
  Walking 7 
 Running Running 1 
  Running 2 
  Running 3 
  Running 4 
  Running 5 
  Running 6 
 Jumping Jumping 1 
  Jumping 2 
  Jumping 3 
 Sports Fencing 1 
  Baseball 1 
  Golfing 1 
 Creative Guitar 1 
Casual Woman Standing Standing 1 
  Standing 2 
  Standing 3 
  Standing 4 
  Standing 5 
  Standing 6 
  Standing 7 
  Standing 8 
 Sitting Sitting 1 
  Sitting 2 
  Sitting 3 
  Sitting 4 
  Sitting 5 
 Reclining Reclining 1 
  Reclining 2 
  Reclining 3 
  Reclining 4 
  Reclining 5 
  Reclining 6 
 Walking Walking 1 
  Walking 2 
  Walking 3 
  Walking 4 
  Walking 5 
  Walking 6 
  Walking 7 
 Running Running 1 
  Running 2 
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Person Position Type Position Name 
Casual Woman (cont’d)  Running 3 
  Running 4 
  Running 5 
  Running 6 
 Jumping Jumping 1 
  Jumping 2 
  Jumping 3 
 Sports Fencing 1 
  Baseball 1 
  Golfing 1 
 Creative Guitar 1 

 
Fixes 

1. Bug description:  When screens containing images are placed on colored 
layers, the rendering shows the layer color around the edge of the screen 
surrounding the image, regardless of whether you choose a custom rendering 
color. 
Fix:  When you choose a custom rendering color for the screen, this is the color 
that now appears in renderings. 

2. Bug description:  Resizing the seating area causes all custom properties, such 
as color, texture, etc. to disappear. 
Fix:  This issue no longer occurs. You can now resize the seating area without 
losing custom properties. 

3. Bug description:  When you use the Seating Wizard to fill a non-rectangular 
seating area, chairs are sometimes drawn outside of the seating area boundary. 
Fix:  You can now use the Seating Wizard to fill a non-rectangular seating area 
and keep the chairs within the seating outline. 

4. Bug description:  When you draw walls interactively while ortho is activated, the 
ortho settings are ignored, enabling you to draw a wall in any direction. 
Fix:  This issue no longer occurs. When you activate an ortho setting, and then 
you draw walls interactively, the walls are only drawn in the direction allowed by 
the ortho setting. 

5. Bug description: On the Images tab, the View menu item "Zoom to 100%" was 
always disabled. 
Fix:  This menu item is now enabled. 

6. Bug description:  When you set a new drawing origin using the Set User Origin 
command, and then you add a piece of truss with the Truss Wizard, the truss 
appears at the wrong trim height because it uses the original origin (ignoring the 
new origin specified). 
Fix:  This issue no longer occurs. When you set a new origin and then you add a 
piece of truss, it is placed at the correct trim height as it uses the newly specified 
origin. For example, if the trim height is 16’ and the origin is 4’, the truss is placed 
20’ off the ground. 

7. Bug description:  When you select a camera in a Shaded view, and then you 
delete the camera, the image in the Shaded view turns black (instead of reverting 
to the default view). 
Fix:  This issue no longer occurs. When you select a camera in a Shaded view, 
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and then subsequently delete the camera, the image in the Shaded view is 
shown from the default perspective.  

8. Bug description:  When you create custom colors on either the General or 
Appearance tab, save and then reopen the file, the custom colors are not saved. 
Fix:  You can now create custom colors on either tab and save the colors so you 
can work with them each time you open the file. 

9. Bug description:  When you export a Vivien file to DWG format and then open 
the same DWG file in Vivien, some layers in the file are rearranged or altered. 
Fix:  This issue no longer occurs. When you export a file as DWG and then open 
the file, the layers, including their properties, remain intact. 

10. Bug description:  When you open a Vivien file in WYSIWYG, any gobos that 
you added to the file appear changed or distorted.  
Fix:  You can now open Vivien files in WYSIWYG without affecting any of the 
gobos in the file. 

11. Bug description:  When you add gobos to either moving or theatre lights, and 
then render the image, the gobos appear distorted in the rendering (they are a 
mixture of the gobos that you chose and the adjacent gobos on the gobo wheel). 
Fix:  When you render files containing gobos, the renderings display only the 
gobos that you chose.  

12. Bug description:  When you mirror a circle, the mirrored copy does not appear 
in the correct location.  
Fix:  This issue no longer occurs. When you mirror a circle it now appears in the 
correct location.  

13. Bug description:  In all drawing views except Plan view, the Fillet tool does not 
function properly (either the arc is not drawn between the lines, or it appears in 
the wrong place).  
Fix:  The fillet tool now functions properly in all drawing views, joining two non-
parallel lines with an arc of the specified radius and grouping both lines and the 
arc together. 

14. Bug description: When you are on the Plots tab and you choose a print scale of 
1:1 for any Plot item (select an item, right-click and choose Item Properties > 
Drawing, then choose the 1:1 print scale), the item does not print to the correct 
scale.  
Fix:  You can now accurately print Plot items at the 1:1 scale. 

15. Bug description: When you mirror an object (for example, a chair), and then 
apply the same custom color to both the original and mirrored object, there is a 
color discrepancy between the two objects when they are viewed in the Shaded 
tab.  
Fix:  Now when you apply the same custom color to both the original and 
mirrored object, the color of both objects is the same in the Shaded tab. 

 
Known Issues 
You can only move a projector (with or without a screen) by clicking and dragging 
the projector beams or screen 
After using the Projection Wizard to add a projector or projector/screen combination to 
your drawing, if you decide to move the projector, you must select it and then move it by 
dragging either the beams emanating from the projector or dragging the screen (if 
applicable); you cannot drag the actual projector to the new location. 
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Library error appears when working in the latest release of Vivien (the version 
installed by downloading the web-only installation file) 
After you download and install the latest build of Vivien 1.2 (the web-only installation 
file), and you open a Vivien file that was created in a previous Vivien build, you may 
receive a library error telling you that up to four library items are not available. All 
previous builds of Vivien included both Vivien and WYSIWYG library items for you to 
use. However, to save download time and installation space, this latest Vivien 
installation file (available by download only) includes only Vivien library items. Therefore, 
if you are working in a Vivien 1.0 file, or if you are attempting to open a WYSIWYG file in 
Vivien, the program notifies you that there are missing library items. Click OK to close 
this error dialog. 

As a workaround, and to keep any of these WYSIWYG-specific library items in your 
Vivien file, you can download the WYSIWYG Compatibility Pack separately (containing 
all WYSIWYG library items).  

 
Spreadsheet border settings are lost when printing to certain printers 
When you are working in the Spreadsheet tab and you have added cell borders to your 
file, all cell borders might disappear from the file after you print the spreadsheet to 
certain types of printers, and then switch to a different tab view in Vivien. (NOTE: The 
Spreadsheet prints with the correct border formatting, but the formatting in the file is 
lost.)  

As a workaround, ensure that you save the file with the cell formatting. You can then 
print the file, if desired, but do not save any changes you make once you have sent the 
file to the printer (since the formatting may be lost, based on the printer used). To 
continue to work with the formatted spreadsheet, open the saved file. 

 
Cannot Copy, Paste, Array, or Move a selection of objects that includes a lighting 
object 
The Copy, Paste, Array, and Move commands do not work on a selected group of 
objects that includes a lighting object. You can perform these commands on individually 
selected lighting objects or groups of selected objects that do not contain a lighting 
object. 

 
Cannot Cut, Copy, or Paste items in the Plots tab 
Copy, Cut, and Paste commands are not available on the Edit menu or toolbar in the 
Plots tab. 

 
Cannot Undo, Redo, or Repeat last command in the Spreadsheet tab 
Undo, Redo, and Repeat commands are not available on the Edit menu or by shortcut 
keys in the Spreadsheet tab. 

 
Contacting Technical Support 
Read the online documentation and visit the www.cast-soft.com web sites before 
contacting Technical Support. You can contact Technical Support at the following 
location. 

 
 

http://www.cast-soft.com/
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Cast Software 
Technical Support 
35 Ripley Avenue, Unit 1  
Toronto, ON M6S 3P2 
Canada 
Toll Free Tel: +1.877.989.2278 
Fax: +1.416.597.9594 
Email: techsupport@cast-soft.com 
Web site: www.cast-soft.com  
 

Copyright Information 
 
© The Cast Group of Companies Inc. 2004-2007. All rights reserved. 
35 Ripley Avenue, Unit 1  
Toronto, Ontario 
Canada M6S 3P2 
 
"Vivien” and “Cast Software” are trademarks of the Cast Group of Companies Inc. Other 
brands or products are the trademarks or registered trademarks of their respective 
holders and should be treated as such. 
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